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New Features in Primavera P6 EPPM 15.2
New features include:
•
•
•
•
•
•
•
•

Global search and replace
HTML-based basic Activities view
Filter on rolling dates
Publish baselines immediately
Assign yourself to a task in Team Member
Filter by projects and WBS in P6 Mobile
Crop and annotate images in P6 Mobile
64-bit installation of P6 Professional
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Usability Enhancements

Usability Enhancements
Usability enhancements in P6 EPPM 15.2 include:
•
•
•
•
•
•
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Global search and replace
Close all projects from right-click menu
Export XML as job service
Save detail windows settings as part of view
Additional filter criteria for codes
An updated login screen

Usability Enhancements

Global Search and Replace
The new Global Search and Replace feature in P6 15.2 enables you to batch update project, WBS, and activity fields.
Create a template and then select up to five fields you want to update. For example, search for activities with a
Primary Resource of Ian Vincent and a Start date that occurs after 01-Oct-15, and then replace with a different
Primary Resource. On the Review Changes page, de-select activities that you don't want to change and select different
values for fields that need further modification.
The Global Search and Replace feature runs as a background service.

To access this feature:
On the Actions menu on the EPS page, click Global Search & Replace.
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Usability Enhancements

Close All Open Projects from the Right-Click Menu
The Close All option is added to the right-click menu on the EPS page. Right-click any row and select Close All to
close all open projects.

To access this feature:
On the EPS page, right-click a project and select Close All.
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Usability Enhancements

View Usage When Assigning Resources
P6 15.2 enables you to access resource usage details when assigning a resource on the Activities or Assignments
pages. In the Select Resource dialog box, click View Usage to view the selected resource's usage data in a spreadsheet
or histogram. This feature allows you to quickly access resource allocation data when deciding whether to assign a
resource.

To access this feature:
In the Select Resource dialog box on the Activities or Assignments page, select the View Usage check box.
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Usability Enhancements

Filter on Rolling Dates
P6 15.2 enables you to filter data on the EPS, Activities, and Assignments page based on rolling dates -- dates or date
ranges that automatically update according to time or project data changes. For example, Current Week is a rolling
date that changes over time and can be applied to a selection of date fields. As the Current Week changes, different
activities are filtered according to the rolling date applied. Create rolling date ranges by adding upper or lower limits.
For example, Actual Finish within range of Current Date and Current Date Plus 2 Weeks will display any activity
whose Actual Finish is within the next two weeks. Use rolling dates to display a dynamically updating selection of
projects, activities, or resources based on the parameters of the filter.

To access this feature:
On the EPS, Activities, or Assignments page, click Add New Filter or open the Modify Filter dialog box.
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Usability Enhancements

Import and Export as a Scheduled Service
P6 15.2 enables you to import and export projects as scheduled services -- for example, make weekly backups of your
projects or share project and baseline data with another organization. Do so by creating an export service to run at a
specified time. You can create multiple import and export services to fulfill different processes within your
organization.

To access this feature:
Click the arrow on the Projects tab, and then click Project Scheduled Services.
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Usability Enhancements

Export XML as a Job Service
Export projects in XML format as a job service, which enables you to continue working in P6 while the service runs
in the background. A notification displays when the service is completed. On the Status tab of the Import/Export
Project dialog box, click Download File to download the XML file.

To access this feature:
On the Actions menu on the EPS page, click Import/Export, XML Project Import/Export.
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Usability Enhancements

Open Log File From a Notification
Click View Log in a notification to open the log file for the service. This feature allows you to view service statuses
and log details in the notification without having to navigate to the Service Status dialog box.

To access this feature:
In the Notifications window that will appear on the bottom left of your screen, click View Log to open the Log File.
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Usability Enhancements

Publish Baselines Immediately
P6 15.2 enables you to publish selected project baselines as an ASAP service without having to republish the entire
project. This feature is useful in situations where baselines have been added or updated since a project was last
published. Publish baselines to bring the necessary reporting tables up to date. You must publish a project before you
can publish any of its baselines.

To access this feature:
Click Define Baselines on the Actions menu on the EPS or Activities Page. In the Baselines dialog box, select a
baseline and click the Publish Baseline icon.
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Usability Enhancements

Save Detail Window Settings as Part of View
In P6 15.2, maintain the appearance of your detail windows by saving your settings as part of a view. Adjust detail
window size, screen position, and column widths, and then click Save View or Save View As on the View menu. You
can collapse the detail windows and save that state as part of the view.

To access this feature:
On the EPS or Activities page, adjust the appearance of your detail windows, and then click Save View.
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Usability Enhancements

Keep Selection After Sorting
In previous versions of P6 your selection reverted to the top row of a list after sorting, de-selecting the row you had
selected. In P6 15.2 the row you select is maintained when you change sorting order. If multiple rows are selected
when sorting, the top row selection is maintained.

To access this feature:
On the EPS, Activities, or Assignments page, click a column header to sort the list of items.
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Usability Enhancements

Database Auditing Improvements
Auditing reports on database tables are faster, more informative, and easier to read in P6 15.2:
•
•

Performance improvements allow you to generate larger auditing reports in less time.
The report format is updated to include more information regarding database table changes, the user
who made the changes, and the application in which the changes were made.

Publish audit data as a Global Scheduled Service to update tables for reporting.

To access this feature:
On the Reports page, run a report on the database tables you want to audit.
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Usability Enhancements

Additional Filter Criteria for Codes
Filter activity, project, and resource codes on two new criteria -- Contains and Does Not Contain. These options are
useful when filtering codes that share some of the same numbers or characters in their values

To access this feature:
On the EPS, Activities, or Assignments page, open the Create Filter or Modify Filter dialog boxes.
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Usability Enhancements

Microsoft Project XML 2013 Support
Import and export projects in Microsoft Project XML 2013 format. Share project data between P6 and Microsoft
Project 2007, 2010, or 2013 by importing and exporting your projects in the corresponding format.

To access this feature:
On the Actions menu on the EPS page, click Import/Export, XML Project Import/Export.
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Applet Removal in P6 EPPM

Applet Removal in P6 EPPM
Starting with Primavera P6 EPPM 8.4, Oracle Primavera began the process of removing Java-based applets from the
application in exchange for pages written in HTML5, which load faster and do not require additional plug-ins. Each
release of P6 will include additional elements converted to HTML5.
The following pages are updated to HTML5 in P6 15.2:
•
•
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The Activities page can be switched to an HTML-based Basic View for basic functionality or the
applet-based Classic View for more complex tasks.
The Open Projects dialog box is now written in HTML5.

Applet Removal in P6 EPPM

Activities Page Basic View
P6 15.2 offers a Basic View for the Activities page that provides basic functionality in a fast and efficient format. Use
the Basic View to manage activities and WBS elements, customize the activity grid layout, edit activity information in
the details pane, and view your schedule in a configurable Gantt chart. Switch to the Activities page Classic View to
perform more complex tasks.
On the User Interface Views page, enable or disable access to the Classic View and Basic View, and choose one to set
as the default Activities page view.

Use the Toolbar to switch between a grid-only view, or a grid and Gantt chart view. Enable Fullscreen mode,
open the Customize View dialog box, and print the current view (Grid View only).
Add, edit, and delete activities in the Grid.
The Row Actions menu allows you to add and delete activities and add, delete, expand, and collapse WBS nodes.
Edit activity information in the Details Pane.
The Gantt chart provides a visual representation of your activities. Customize bars, labels, colors, timescale, and
lines in the Customize View dialog box.
Switch between the Activities page Classic View and the Basic View.
To access this feature:
Click Activities on the Projects Navigation bar.
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Applet Removal in P6 EPPM

Open Projects Dialog Box
The Open Projects dialog box is now HTML-based, providing a quicker experience when opening projects. Toggle
between available Projects or Templates and organize the list of available items by EPS, Portfolios (Projects only), or
Project Codes. Enter a search term to filter the list. If you have the Classic View enabled, select an Activity View for
your opened projects; view users currently in projects; and then open your selections exclusively.

To access this feature:
Click the arrow on the Projects tab, and then click Open Projects.
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P6 Team Member

P6 Team Member
P6 Team Member 15.2 enhancements include:
•
•
•

Assign yourself to an existing task
Filter tasks by WBS
An updated user interface and login screen
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P6 Team Member

Assign Yourself to an Existing Task
If you worked on a task to which you are not yet assigned, click the Assign Tasks button on the My Tasks page to
assign yourself as a resource to the task. (You can only report time on tasks to which you are assigned.) Select a
project, and then select one or more tasks to add to your My Tasks list.

To access this feature:
On the My Tasks page, click Assign Tasks.
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P6 Team Member

Filter Tasks by WBS
In P6 Team Member 15.2, use the WBS filter to further refine the list of tasks on the My Tasks page. Select a project
in the Projects filter and then select one or more WBS nodes for the tasks that you want to display.

To access this feature:
On the My Tasks page, click the WBS filter.
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P6 Mobile

P6 Mobile
P6 Mobile enhancements for 15.2 include:
•
•
•
•
•
•
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Assign yourself to tasks
Additional task filters
Crop and annotate attached images
Demo mode
Timesheet improvements
View task location details and mapping directions

P6 Mobile

Assign Yourself to an Existing Task
Tap the + button on the My Tasks page to assign yourself as a resource to one or more tasks. Project managers can see
the task assignment on the Review Status Updates page in P6.

To access this feature:
On the My Tasks page, tap +.
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P6 Mobile

Toggle Project ID in Task Details
Toggle the display of the Project ID field in task details on the My Tasks page and Timesheets list. Preference settings
only apply to your instance of the application.

To access this feature:
On the P6 Settings page, slide the Display Project ID switch to On.
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P6 Mobile

Timesheet Improvements
Timesheets on the Timeframe Selection page are now marked with bars to indicate action is required:
•
•

A blue bar marks the current timesheet.
A red bar marks rejected, reactivated, and overdue timesheets.

Submit the timesheet to remove the indication. Once submitted, the date and time of the last submitted timesheet is
displayed on the navigation menu.

To access this feature:
On the navigation menu, tap Timesheets.
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P6 Mobile

Additional Task Filters
Refine your task list by applying filters. In addition to the current Status and Timeframe filters, you can now apply
Location, Project, and WBS filters. Filter task lists by one or more projects, and then choose individual WBS elements
whose tasks you want to view. In the Location filter, view tasks assigned a specific location or choose Near Me to
view tasks within a specified distance of your current location. Apply a combination of filters to quickly find a
selection of tasks from hundreds or thousands of available tasks.

To access this feature:
On the My Tasks page, tap the Filters icon.
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P6 Mobile

Demo Mode
P6 for iOS 15.2 provides a Demo mode that allows you to access the application without providing user credentials or
server information. You can modify tasks details, view settings, and update timesheets in Demo mode. Changes you
make to the sample data are not saved to a server. Demo mode is for P6 for iOS only.

To access this feature:
On the login page, tap Demo.
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P6 Mobile

Set Task and Timesheet Reminders
Configure reminders to display for your tasks and timesheets. Reminders appear before the next task is set to start or
when your next timesheet is due to be submitted.
For each task reminder, select a time for the reminder to appear -- for example, 2 days before. Task reminders display
for all tasks assigned to you.
For each timesheet reminder, select a day and time -- for example, 2 days before at 4 pm. Set multiple reminders if
you want to be reminded multiple times -- for example, one day before a timesheet is due and then one day after.
When a reminder appearsm, select Dismiss to close the reminder or View Task or View Timesheet to navigate to the
corresponding page. Task reminders are for P6 for iOS only.

To access this feature:
On the navigation menu, tap Settings.
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P6 Mobile

Crop and Annotate Images
P6 for iOS 15.2 enables you to crop and annotate an image before assigning it to a task or attaching to an email. For
example:
•
•

Crop and zoom to focus on an important area.
Draw shapes, lines, and text using a variety of colors and line widths.

To attach a photo, you must be connected to a P6 server configured with a content repository.

To access this feature:
On the My Tasks page, select a task, and then tap the camera icon in the task details.
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P6 Mobile

Subscribe to Mobile Calendars by Project
P6 for iOS 15.2 enables you to subscribe to a calendar containing all of your assigned tasks or tasks from selected
projects. On the Settings page, select My Owned/Assigned Tasks to subscribe to the calendar.
Navigate to the Calendar app to view tasks for each calendar by day. View task dates, task status, project name and
ID, and WBS. Toggle the display of individual calendars from your Calendar app.

To access this feature:
On the P6 Settings page, tap Calendar Subscriptions.
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P6 Mobile

View Task Location Details
A new Map View in P6 for iOS 15.2 shows the location of your tasks as pins on a map. Tap a pin to view the location
and projects assigned to that location. Receive navigation directions from your current location to a pin location using
your device's mapping application. In the task list, view the distance of each task from your current location. When
you apply location filters to your task list, the map will zoom to fit any pins that match your filters. This feature is
available for P6 for iOS only.

To access this feature:
On the My Tasks page, tap the map icon.
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P6 Professional

P6 Professional
Enhancements in P6 Professional 15.2 include:
•
•
•
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64-bit installation
Additional filter criteria for codes
Export as job service

P6 Professional

64-Bit P6 Professional Installation
Primavera P6 Professional 15.2 is available as a 64-bit installation. If you are running a 64-bit operating system,
choose between a 32-bit or 64-bit version during application installation.
64-bit offers key advantages over the 32-bit version of P6 Professional:
•
•
•
•

Handle larger and more complex projects, with faster response time from P6 Professional
components.
An upgrade from the ANSI character set to the Unicode standard enables you to work with multiple
languages in P6 Professional at the same time.
Higher memory ability leads to better performance.
Crashes due to memory issues are reduced.
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P6 Professional

Additional Filter Criteria for Codes
Filter activity, project, and resource codes on two new criteria -- Contains and Does Not Contain. These options are
useful when filtering codes that share some of the same numbers or characters in their values.

To access this feature:
Select a code in the Filter dialog box.
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P6 Professional

Export XML as a Job Service
Export projects in XML format as a job service, allowing you to continue working in P6 Professional while the
service runs in the background. A notification displays when the service is completed. In the Job Status dialog box,
click Download File to download the XML file. This functionality is not available in Standalone mode.

To access this feature:
On the File menu, click Export.

35

P6 Professional

Copy Project as a Job Service
Copy Projects as a Job Service
Copy projects or EPS nodes as a job service in P6 Professional 15.2, allowing you to continue working in P6
Professional while the service runs in the background. A notification displays when the service is completed. View
the status of the service in the Job Status dialog box. This feature requires connection to a P6 EPPM database.

To access this feature:
On the Projects page, select a project or EPS node, right-click and select Copy. Highlight a new location, right-click,
and select Paste.
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P6 Professional

Save Resource Selection in the Resource Histogram and Spreadsheet
When you select resources in the Resource Histogram or Spreadsheet and then close P6 Professional, those selections
are maintained the next time you start the application. This new feature in P6 Professional 15.2 saves time by
retaining your resource selections. The selected resource filter -- All Resources, All Active Resources, or Current
Project's Resources -- is also maintained. The state of the resource histogram and spreadsheet can be saved as part of
the layout.

To access this feature:
Update your resources using the Resource Usage Spreadsheet or Resource Usage Profile, and then save your layout or
close the application.
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P6 Professional

Microsoft Project XML 2013 Support
P6 Professional 15.2 enables you to import and export projects in Microsoft Project XML 2013 format. Share project
data between P6 and Microsoft Project 2007, 2010, or 2013 by importing and exporting your projects in the
corresponding format.

To access this feature:
On the File menu, click Import or Export.
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P6 Professional

Select Language at Login
P6 Professional 15.2 enables you to choose your language in the Login dialog box before you log in. This
enhancement makes it easier to change your language of choice. The Set Language option on the Tools menu is
removed from the application.

To access this feature:
In the Login dialog box, choose a language from the list.
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